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Preface

Purpose of this book
This Getting Results book provides you with informtion on how to install and 
navigate RSLogix 500.  This guide includes troubleshooting information and 
tips on how to use RSLogix 500 effectively.  It also explains how to acess and 
navigate the online help.

Intended audience
We assume that you are a control engineer familiar with:
n IBM-compliant personal computers
n Microsoft® Windows® 95, Microsoft Windows 98®, or Microsoft Windows 

2000™

n Rockwell Automation’s class of SLC (small logic controllers).

Document conventions
This manual uses the following typographical conventions:
n [Bold] characters in brackets represent keystrokes used to execute a 

function. When more than one key is to be pressed at a time, the keys are 
separated by a plus sign.  For example, [Ctrl + v] means hold down the 
[Ctrl] key and press the [v] key.

n Bold characters represent menu choices.
n TEXT IN THIS FONT represents characters that you should type.

Online help
If you need help while using RSLogix 500, use any of the following methods:
n choose Help from the menu bar
n click the Help button on any RSLogix 500 dialog
n press [F1] on any instruction, dialog box, or window view.
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Commonly used terms
The following table defines terms commonly used in this book. 

This term: Represents this concept:

activation files Hidden files in the root directory that allow the software to run.  
The software checks for these files before you have access to 
offline or online programming

archive Backups of production files. Can be used for version control. 

back up Keep a copy of the current file before replacing that file with an 
updated version.  

download Restore a specified file to a specified processor.  For example, 
when you download the current project file, you copy the file to 
a specified processor so the processor can begin running that file.

library A file into which you store or from which you retrieve portions 
of ladder logic.

mnemonic A term, usually an abbreviation that is easy to remember.  The 
PLC instruction set is typically represented by a 3-letter 
mnemonic.   

project All of the files that make up the SLC 500 logic program including 
the documentation files.

upload Access an SLC processor and save a copy of the project. 

verification An analysis of the ladder program files that result in the display 
of any  programming errors.

zone Portion of the ladder logic identified by a marker indicating the 
edited state of the file.
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Chapter

Getting Started with 
RSLogix 500

Welcome to RSLogix 500
The RSLogix 500 software is a 32-bit Windows ladder logic programming 
package for the SLC 500 and MicroLogix processors.
Operating in the Microsoft Windows 95, Microsoft Window 98, Microsoft 
Windows 2000 and Windows NT™ environment, RSLogix 500 is compatible 
with programs created with any of Rockwell Software’s DOS-based 
programming packages.  If you are using Windows NT, it must be Version 4.0 
with Service Pack 4 or later.  
RSLogix 500 software functionality includes:
n a free-form ladder editor that lets you concentrate on the application logic 

instead of proper syntax as you write your program
n a powerful project verifier that you use to build a list of errors you can 

navigate to make corrections at your convenience
n drag-and-drop editing to quickly move data table elements from one data file 

to another, rungs from one subroutine or project to another, or instructions 
from rung to rung within a project

n search and replace to quickly change occurrences of a particular address or 
symbol

n a custom data monitor to view separate data elements together and observe 
interactions

n a point-and-click interface called a project tree that lets you access all the 
folders and files contained in your project 

n trending and histogram functionality for monitoring and displaying process 
data

n SLC libraries for storing and retrieving portions of ladder logic for use across 
any of Rockwell Software's SLC programming software products.

n a compare utility that lets you graphically view project differences.



2  n   Getting Results with RSLogix 500

Exploring RSLogix 500
To navigate through the various windows and toolbars in RSLogix 500 more 
easily, you should understand what they contain and what functionality each 
provides.
When you open a project in RSLogix 500 you can expect to see:.

n Menu bar - Select functionality from the menus that appear as you click each 
selection on this bar.

n Icon bar - The icon bar contains many functions that you will use repeatedly 
as you develop and test your logic program.  If you want to know what any 
of the icons represent, RSLogix 500 can tell you.  Just move your cursor to 
the icon.  A floating ToolTip window will appear and tell you what the icon 
is used for.

n Online bar - Learn the operational mode and see whether you have online 
edits or forces installed at a glance.  You can even view the driver and node 
number.

Menu bar
Icon bar
Online bar

Project tree

Results pane

Status bar

Ladder view                 Instruction toolbar
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n Project tree - This view contains all the folders and files contained in your 
project.  You can usually click an icon in this tree and then click the right 
mouse button for a menu that applies only to the icon selected.  For example, 
if you click the right mouse button on a program file, you see options to 
rename the program file, open the program file, hide the program file, or 
reveal properties of the program file.

n Status bar - Look here for ongoing status information or prompts, as you 
use the software.

n Results pane - Displays the results of a Find All search or a verification 
procedure.  You can hide this window view or separate it from the 
application window so that it can be placed anywhere on your screen.

n Ladder view - In this part of the application window you can view several 
program files at the same time.  This is where you edit your ladder logic.

n Instruction toolbar - Displays instruction mnemonics in tabbed categories.  
When you click on a category tab the instruction toolbar just above it 
changes to show that category of instructions.  Click an instruction to insert 
it in your ladder program.

Quick Start Steps
The following steps explain how to get up and running quickly with RSLogix 
500 as soon as you install it. 

Step 1  •  Configure system communications
Do this before you begin a new project.  The settings you establish with this 
step will remain with the project and will be applied when you attempt to 
download any logic program.
From the Comms menu, click System Comms. Then Select a  driver from the 
list of drivers in the left pane of the Communications window.  Clicking on a 
driver displays the devices available for connection in the right (Who Active) 
pane of the window.

Tip You may find it more convenient to use a floating instruction palette 
from which you can select any instruction available to your 
processor.  Click [Alt+4] to view the palette.  You can resize the 
palette by dragging its lower edge.
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If the driver list is empty, launch RSLinx by selecting the RSLinx.exe file from 
its resident directory on your hard drive.  Once you have launched RSLinx, if 
the driver list is still empty, you must configure a driver.

To complete the configuration, click the processor you want to communicate 
with (in the Who Active pane).  From this point you can go online or upload 
the ladder program from the selected processor to display it in RSLogix 500. 
The figure above is only an example configuration using RSLogix Emulate 500 
(EMU500-1) as the driver.  Your configuration will vary.
For more detailed information about functionality available to you in the 
Communications dialog refer to chapter 3 in this book.

Step 2  •  Create a new project or open an existing 
project
New Project
RSLogix 500 is based on projects.  Projects are the complete set of files 
associated with your program logic.  You create a project from the File menu 
by clicking New.  RSLogix 500 prompts you for the type of processor you will 
communicate with and creates a project tree control.  This project tree is your 
access point to program, data table, and database files.

Tip If you need help configuring a driver you can receive step-by-step 
instructions from your RSLINX help file.  To get RSLINX help: 
open RSLINX by clicking the RSLINX icon on your desktop, then 
from the Help menu click Quick Start. This displays the information 
you need to configure a driver.

Choose visual or textual Who Active display

Who Active Display

Driver selection



Getting Started with RSLogix 500   n  5

Existing Project
From the File Menu, click Open.  Use the dialog that appears next, to Open a 
ladder logic project and/or its associated database.  Depending on the type of 
action (open or import) RSLogix 500 presents a default file extension.  You 
may however, select a different file type to open or import.  Make sure you have 
the correct type of file listed in the Files of Type drop-down listbox on the 
Open/Import SLC 500 Program window.

Tip You can hide any program file (except system files) in the project 
tree.  This can be useful once you’ve completed editing a program 
file and don’t want to risk accidentally selecting it and making 
changes.  Click on the file in the project tree and then select Hide 
from its context (right-mouse) menu. 

Tip Compare project files easily by clicking Tools > Compare.  Then 
select the projects you want compared.  You can print the resulting 
graphical display or save it to a report and print it later.

This symbol (-) means
that the folder’s con-

tents are already visible.
Click the symbol to col-

lapse the folder and
hide its contents.

This symbol (+) means
that the folder contains

files that are not yet
visible in the project

tree.  Click the symbol
to expand the folder and

reveal its contents.

You can rename files.  If 
you do, the name you 
give it will be shown 
instead of the default.  
Program files 0 and 1 are 
internal files and cannot 
be renamed.
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Opening Multiple Files
To open multiple files within the same project you can split the viewing 
window.  

Use your pointing device to point to the split bar.  The cursor turns into a 
double bar with two arrows.  Drag the bar up or down to its new position 
allowing you to see two views of the window.
You cannot view program files from different projects with only a single 
RSLogix 500 application running on your computer.  You must open more 
than one application to work on multiple projects at the same time.  Once you 
have the project opened however, you can drag-and-drop instructions and data 
between them.

Step 3  •  Create program and data table files
The project tree (also referred to as project directory) is your point-of-entry for 
creating new files or accessing existing files.  To create a new file, right-click the 
program or data file icon and then select New from the menu.  You will be 
prompted for information about the file.

Program files contain controller information, the main ladder program, and any 
subroutine programs.  The number of program files you can have in your 
ladder project is determined by the type of controller you are using.
Data table files contain the status information associated with external I/O and 
all other instructions you use in your main and subroutine ladder program files.  
In addition, these files store information concerning controller operation.  You 
can also use the files to store recipes and look-up tables if needed.

Split bar

Position your cursor over the
folder then click the right

mouse button and choose
New to open a new file.
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Step 4  •  Define chassis and modules
After you have opened a project, you have to define your chassis, identify the 
I/O cards that you are using by indicating their slot position within the 
processor rack, and select a power supply for each rack in your configuration.  
A real application might have up to three racks and many I/O modules.  
You perform these procedures in the I/O Configuration window.  Access this 
window by double-clicking the I/O Configuration icon in the project tree.  
Then click a module in the list on the right side of the window and drag it into 
the slot where you want it to reside.
From the I/O Configuration window, click the Power Supply button to 
examine the loading on a rack based on the module configuration that you have 
selected.

For more information about other tasks you can accomplish from the I/O 
Configuration window refer to chapter 4 in this book.

Step 5  •  Enter a logic program
When you open a program file by double-clicking its icon in the project tree, 
the ladder file opens in the right side of the RSLogix 500 window.  Usually 
program file #2, the main program file, will be opened when you open a 
project.  If you have not begun to enter any ladder logic, only the end rung will 
show.
Click the end rung and then select the new rung icon from the user toolbar.  To 
place an instruction on a rung, click its icon on one of the toolbars.

.
First, click a module in this list

Next, while still holding the mouse button,
drag the module to this side.
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You can place several instructions on a rung in sequence by clicking the icons 
one after another.  RSLogix 500 places instructions from left to right.
RSLogix 500 supports a file-based editor.  This means that you can:
n create and/or edit multiple rungs at a time
n enter addresses before you actually create data table files for your I/O
n enter symbols before you have assigned addresses for them in the database
n enter instructions without having to provide addresses until just before file 

validation occurs
To add addresses just click an instruction and then type the address in the 
empty field that appears above the instruction.  With RSLogix 500 you can also 
drag and drop addresses from a data table file onto instructions in your ladder 
logic. 
Remember to use the right mouse button to access functionality whenever 
possible.  The right mouse button provides you with context menus that list 
editing options.  And always remember that you can click F1 (or the Help 
button when available) on any instruction, or within any window to access help.
Keyboard users can press the [Shift + F10] key combination to access a right 
mouse menu.

This is the “new 
rung” icon.  Click it 
to place a new rung 
on your ladder.

Each of these tabs 
displays a different 
category of instructions in 
the toolbar.  You can 
customize the categories.

If there are too many
instructions on the toolbar
to see them all, use these

arrows (right and left) to
scroll through the list.
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For more detailed information about the steps you follow to enter the ladder 
logic including information about branching, addressing, and performing 
program edits online, refer to chapter 5 in this book.

Step 6  •  Add documentation to your logic 
kkkkkkkkinstructions
You can use several method to add symbols and descriptions to addresses in 
the database.
n Open the program file and add the documentation directly to the addresses 

instruction.  Use the right mouse menu for this.
n Modify an address’s assigned documentation in the data file.  Double-click 

the data file in the project tree, and then click on an address within the grid 
that appears on the data file dialog.  At the bottom of the dialog there are 
fields where you can enter the documentation for the address.

n Modify the database using the database editor.  Double-click an icon in the 
database folder located in the project tree.  

n Enter a symbol directly and later assign an address to the symbol using the 
database symbol/description editor. 

For information about the database import and export options available to you 
refer to chapter 6 in this book.

Step 7  •  Verify the program logic
When you are ready to build your project, you can validate a single program file 
or you can validate your entire project.  Use the menu bar or the right mouse 
button menu to initiate this process. 

Tip You can select multiple rungs by holding down the [Ctrl] key and 
clicking the left mouse button on every rung you want to select.  You 
can also select a range of rungs by holding down the [Shift] key and 
clicking the beginning rung and ending rung.
When you select rungs in this manner, RSLogix 500 remembers the 
order in which you made your selections, and pastes the rungs to the 
clipboard in that order.  When you paste the rungs, the order in 
which you copied them is retained.  For example if you click rung 11 
and then [Shift] click rung 8 to copy a range of rungs, the rungs are 
copied to the clipboard from rung 11 to rung 8.  Pasting these rungs 
will place them in the new location in this same order.
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After you initiate a verification, the Verify Results output window displays and 
gives you information about mistakes or omissions that may have occurred as 
you wrote your program logic.

Step 8  •  Configure communication channel, 
kkkk.kkkkkdownload and go online

Before going online you have to define processor communication settings, 
such as baud rate, and also decide certain system and protocol controls.  
Depending on the type of processor that you are using and the method of 
communication (direct vs. networked or modem), the complexity of this 
procedure varies.

Tip If you are developing the program offline, for example on a laptop 
remote from the site, and later plan to download and run the 
program on a specific processor (node) via a determined protocol, 
you may want to override system communication settings made in 
step 1. Do this from the Controller Properties window, Controller 
Communications tab.  Settings made via this method will override 
any driver and node settings established in step 1, and should be 
completed before performing this step.

The results of any verification are
displayed at the bottom of the window 
under the project tree.  To hide this 
results window after viewing it, click the 
View menu and then click Results.
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Double-click the channel configuration icon in the project tree to make these 
settings.  If you need information about any parameter, click Help on the 
channel configuration window.
Finally, from the Comms menu, click Download to download the current 
offline program into the controller.  RSLogix 500 will ask if you want to go 
online.  Click Yes to go online; then select the operating mode.

Step 9  •  Monitor data files
You can use RSLogix 500 to watch what is happening in your data table files.  
This procedure is called monitoring data table files.
While monitoring these files you can:
n define how your data file selection grid will display
n change values in the data table
n change the display radix
n show which addresses are used in your ladder logic
n switch between files
n quickly jump to another address in another data table file
Double-click the data file icon in the project tree that contains the data you 
want to monitor.  You can have multiple data table files opened for monitoring 
at the same time.  Just drag each data table window into viewing position by 
clicking on the title bar and moving the mouse.  Release the mouse button to 
place the data table window.
You can also choose to cascade or tile all the windows opened in your RSLogix 
project by selecting a viewing option from the Window menu.
Data changes made offline only affect the disk file unless the program is 
restored to the processor.  
Data changes made online only affect the processor file unless the program is 
saved or uploaded while online to update the disk file.  
For other tips about how you can create and monitor lists of related addresses 
instead of accessing the data table files, refer to chapter 7 in this book.

Step 10  •  Search and replace instructions
The Find option allows you to quickly locate instructions, addresses, and 
symbols (if they have been defined) in ladder program files.  You can even 
search for edit zones within your logic program.  If you want to automatically 
replace instructions and addresses with different ones, you can use the Replace 
option.  Wildcards may be used in your search.
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Begin any Find or Replace operation from the Search menu.  Then type the 
mnemonic (XIC, TON, etc.), the address (B3/4, etc.) or a combination of both 
mnemonic and address (XIC B3/4) or mnemonic and symbol (XIC REPEAT) 
for the instruction you want to locate in the Find What text box. 

Step 11  •  Print a report
When you need a printed copy of what you've done in RSLogix 500, you need 
to print reports.  There are many reports available and you can select which 
reports you want to print from the Report Options dialog.  Select this dialog 
from the File menu.

Tip You can quickly navigate to a program file, rung, address, symbol or 
data table file.  Press [Ctrl+G] to display a Goto dialog.

Tip To preview the way a ladder file will print, click Preview.  You can 
scale up the image to make the instructions appear larger on the 
printed page or scale down the image so that in cases where many 
instructions are on a rung of logic, all the instructions can fit on the 
printed page.

An alternative method for searching is to click in-
side this box and type the numeric or symbolic ad-
dress or the instruction mnemonic you want 
searched.

To learn the function of any icon, point to the icon without clicking.
A tooltip like this will appear and briefly define the function.
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Chapter

Installing RSLogix 500

Introduction
This chapter explains how to install and start RSLogix 500 software. This 
chapter includes information on the following:
n system requirements
n installation methods
n installation procedures
n updating an existing installation
n starting procedures
After installing the software, we recommend that you read the release note 
located in the online help. The release note may contain more up-to-date 
information than was available when this document was published.

System requirements
To effectively use RSLogix 500, your personal computer must meet the 
following hardware and software requirements:

Hardware requirements
n a Pentium™ or Pentium-compatible microprocessor
n 32 MB of RAM for most processors except 64 MB of RAM recommended 

for  64Kbyte SLC 5/03, 5/04 or 5/05
n 10 MB of available hard disk space 
n 16-color VGA Graphics Adapter 640x480 or greater resolution (256-color 

800x600 optimal)
n a CD-ROM drive

Important If you are running Windows NT® and performing the tasks that you 
will read about in this chapter, you must have the Windows NT 
system administrator privileges and your user account must be a 
member of the local administrator user group.  For more 
information, contact your system administrator.
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n a 3.5-inch, 1.4 MB disk drive
n any Windows compatible pointing device

Software requirements
n The operating system must be one of the following:

a. Microsoft® Windows® 95
b. Microsoft Windows 98® 
c. Microsoft Windows 2000™ (RSLogix 500 r4.00.00 is designed to be 

Windows 2000 Ready) 
d. Windows NT 4.0 with Service Pack 4 or greater.  

RSLogix 500 will not run under Windows 3.1, or Windows for Workgroups 
using the 32-bit extensions to these environments, or Windows NT 3.51 
operating systems.

n You must use RSLinx™ version 2.00.175 or later communication software 
with all operating systems. 

Installation methods
The RSLogix 500 software supports the following methods of installation: 
n standalone workstation
n network

Standalone workstation
In a standalone workstation installation, you can install one or more Rockwell 
Software products to a single personal computer. Select the required Rockwell 
Software product and each required component for installation.
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Network
The network installation allows multiple users to run one or more Rockwell 
Software products from a central network location. During the network 
installation, a system administrator installs one or more Rockwell Software 
products to a network location. Common application files, which are not 
specific to the operating system, are stored at this network location. These 
application files are then available to users of the network.

Installing RSLogix 500 
To install RSLogix 500 software, perform the following steps: 

1. Start your Windows operating system if it does not start automatically.
2. Insert the RSLogix 500 CD-ROM into the CD-ROM drive.

Tip The Setup program creates the following subdirectory on the user-
defined network location path:x:\Program Files\Rockwell 
Software\RSLogix 500 English.  This subdirectory contains all of 
the application files required to run the product.

Tip While installing RSLogix 500 software, you will have the 
opportunity to specify a directory. The suggested default directory 
is:  x:\Program Files\Rockwell Software\RSLogix 500 English.  
The language suffix changes for the different languages supported 
by RSLogix 500.  While you can change the path, please note that 
the "RSLogix 500 English" portion of the path is fixed and cannot 
be altered.
We recommend that you use the default directory whenever 
possible.  In procedures that appear throughout this document, we 
assume that you used the default name. If you did not use the 
default name, substitute the actual name you specified for the 
default name shown.  Once you have installed the software  
remember to move your existing project files if necessary to the 
new project directory.

If autorun is: Then:

enabled The Setup program starts automatically and the Welcome 
dialog box appears. Proceed to step 3
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3. Follow the instructions that appear on the screen.
a. On the Welcome dialog box - Read the RSLogix 500 introductory 

information, and then click Next.
b. On the Software License Agreement dialog box - Read the entire 

Software License Agreement. Click Yes to accept and continue 
installation, or click No to decline and exit the installation.

c. On the Registration Information dialog box - Type your name, the 
name of your company, the support ID number of your RSLogix 500 
software, and then click Next.

d. On the Select Folder dialog box - Select a directory location for the 
RSLogix 500 application files.

A dialog box appears, indicating that a RSLogix 500 subdirectory will 
be created in the specified destination directory. Click Yes to confirm, 
or No to exit.

disabled Perform the following steps:
a. Click Start, then click Run. The Run dialog box 

appears.
b. In the Open field, type x:\setup, where x is the letter 

of the drive containing the RSLogix 500 CD-ROM.
c. Click OK. The Welcome dialog box appears.

If autorun is: Then:

Tip You can find the support ID number on the product box 
label.

If you are 
installing to:

Then:

Standalone 
Workstation

Accept the default destination directory location, 
or select a new destination directory in which you 
want the RSLogix 500 files to be copied, then click 
Next. 

Network Specify a network destination directory in which 
you want the RSLogix 500 files to be copied, then 
click Next.
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e. On the Select Components dialog box - Select installation options. In 
the Product (left) pane, select the RSLogix 500 product(s) that you 
want to install. In the Product Options (right) pane, select the 
component(s) of each product that you want to install. Click Next.

f. On the Specify Start Menu Item dialog box - Accept the default 
program folder, or type the name of the program folder in which you 
want the RSLogix 500 application icons to appear. Click Next.
A dialog box appears, indicating the specified location of the RSLogix 
500 icons in the Start menu. Click Yes to confirm, or No to exit.

g. On the RSLogix 500 dialog box - Confirm your previous selections, 
and then click Next. The Setup dialog box appears while files are 
being copied to the hard disk drive. 

h. On the Setup Says! dialog box - Review the Rockwell Software 
contact information, then click Next.

i. On the Setup is Complete dialog box - Select the activation and 
readme viewing options and click Finish.
To begin activation, insert the Master disk into the 3.5-inch disk drive.

j. On the EVMOVE dialog box - Follow the instructions that appear on 
the screen to activate RSLogix 500 software. For more information 
on activation, see Appendix A.

k. On the Restart Windows dialog box - Specify the restart option for 
your operating system and click Finish. The installation is complete.

4. When you are finished installing the software, remove the RSLogix 500 
CD-ROM from the CD-ROM drive and the RSLogix 500 Master disk 
from the disk drive. Store them in a safe place.

Running a network installation
As a user of a network installation, you can run one or more Rockwell Software 
products from a specified network location. To run RSLogix 500 software in 
this manner, perform the following steps: 

Important When the network installation is complete, the system 
administrator should notify all users of the dedicated location 
where all of the Rockwell Software files have been installed.
In addition, the system administrator must share the applicable 
directories to enable the users to perform the installation 
procedure. 
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1. Map a network drive, or navigate through Windows Explorer, to the 
network location provided by your system administrator. The default is:  
x:\Program Files\Rockwell Software\RSLogix 500 English (where x is 
the drive where the application files are installed).

2. Click Start, and then Settings > Control Panel.
3. From the Control Panel, double-click the Services icon.

The Services dialog box appears.
4. Select the RS500 software service, and then click Start.

Updating an existing installation
Perform the following steps to update an existing installation:
1. Insert the RSLogix 500 CD-ROM into the CD-ROM drive.

2. On the Uninstall Required dialog box, confirm that the current version 
and the version to be installed are correct, then click Next.

3. Click Yes to confirm the uninstall procedure. 
The Remove Programs from Computer dialog box appears.

4. Click OK. 
The Welcome dialog box appears. 

If autorun is: Then:

enabled The Setup program starts automatically and the Welcome 
dialog box appears. Proceed to step 3.

disabled Perform the following steps:
a. Click Start, then click Run. The Run dialog box 

appears.
b. In the Open field, type x:\setup, where x is the letter 

of the drive containing the RSLogix 500 CD-ROM.
c. Click OK. The Welcome dialog box appears.
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5. Follow the instructions that appear on the screen. For more information, 
see the “Installing RSLogix 500 Software” section in this chapter.

Creating a floppy disk installation
You can create a floppy disk installation set for RSLogix 500 software.  You 
would do this if the computer onto which you are installing the software does 
not have a CD-ROM reader.
To create a floppy disk installation:
1. Insert the RSLogix 500 CD-ROM into the CD-ROM drive.
2. If the setup program starts automatically, cancel it.
3. Perform the following steps:

a. Open My Computer, then open the CD-ROM drive.
b. In the window showing the contents of the CD-ROM drive, open the 

Disks folder.
c. Double-click the MAKDISKS.BAT file.
d. Follow the on-screen instructions.

Starting RSLogix 500 software 
To start RSLogix 500 software: 

Tip If activation was previously installed, it is not necessary to move the 
activation. If activation was not previously installed, insert the 
RSLogix 500 Master disk into the 3.5-inch disk drive and follow the 
instructions that appear on the screen. For more information on 
activation, see Appendix A.

As a: Do the following:

Standalone workstation 
user

Click Start, and then select Programs > Rockwell 
Software > RSLogix 500 English > RS500  from the 
Start menu. 

Network user Double-click the product executable (for example, 
RS500.exe) located in the \RSLogix 500 English 
\System network subdirectory specified by your 
system administrator.
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Troubleshooting installation
If RSLogix 500 does not start up or run properly, keep the following in mind: 
n Do you have the correct version of RSLinx installed?  The software requires 

RSLinx version 2.00.175 or later. 
n Does your computer have enough memory? Check the hardware 

requirements on the first page of this chapter for memory requirements. 
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Chapter

Configuring 
Communications

System communications vs. controller 
communications

Is there a difference?
There are two methods that you can use to supply communication parameters. 
n Use the system communications dialog (accessed from the Comms menu by 

clicking System Comms) to indicate the communication configuration for a 
processor that you would like to connect to.  This method of communication 
is not related to your project.  In fact, typically you supply these parameters 
even before beginning work with a project.  For example, you may want to 
upload an existing project from a processor and then modify that project in 
some way for use on another processor. 

n Use the controller communications dialog (accessed by double-clicking the 
Controller Properties icon in the project tree and then selecting Controller 
Communications) if you want the driver and node settings that you enter to 
stay with the project.  Often this is the case when you use a laptop computer 
and develop a project offline.  You will want the driver and node information 
that you supply for use with your project to override system communication 
parameters when you later download the project to a specific processor.

On the controller communications dialog there is a drop-down list box that 
shows you the previous communication configurations that were used.  You 
can look this list over to see if the driver and node of the processor you want 
to communicate with is listed.  If you see it in the list, just double-click it to re-
establish the parameters.

Configuration parameters for all 
previous processor configura-
tions are retained in this drop 
down list box on the controller 
configuration tab.  Your parame-
ters will vary.

TCP-1               Node  7o  local



22  n   Getting Results with RSLogix 500

Who Active
Another convenience available from both communication dialogs is the Who 
Active function.
The Who Active function relies on the communication dialog’s network display 
feature to show you what stations are connected on your SLC network.  You 
can use this information for selecting stations to upload from, download to, or 
monitor online.  You can also display statistics about how your 
communications are performing.
When you use RSLogix 500 to call for a Who Active, RSLogix 500 calls RSLinx 
and activates the Communications function.  If RSLinx is not installed on your 
computer, RSLogix 500 calls the RSLinx Lite communication driver that is 
included in the RSLogix 500 software.
Once the Communications window is displayed you can choose to view your 
network configuration graphically or in text mode.

Graphic view icon              Text view icon         

(Example network data)
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Chapter

Chassis and Module 
Setup

Introduction
After you have opened a project, you have to define your chassis, identify the 
I/O cards that you are using by indicating their slot position within the 
processor rack, and select a power supply for each rack in your configuration.  
A real application might have up to three racks and many I/O modules. 

The I/O Configuration dialog lets you do other tasks also.
n You can learn if the power supply you have planned to use will supply 

enough power for the modules you have placed in the rack.
n You can configure your analog and other specialty modules.
n You can automatically read the existing I/O configuration of a processor 

node on the network.

Click this button to 
call a dialog (shown) 
allowing you to select 
a processor from 
which you want to 
read the 
configuration.
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Power supply loading

Access the Power Supply Loading dialog by clicking Power Supply on the I/O 
Configuration dialog.  The Power Supply Loading dialog is informational only.  
You cannot establish any settings on this dialog.  Use it to examine the loading 
on a rack based on the module configuration that you have selected.

Analog and specialty module configuration
If you have a Specialty I/O Module in your configuration, you have to enter 
additional parameters so that the module can function properly in your 
program.  You enter this information in the Advanced I/O Configuration 
window.  Go to this dialog by clicking the Adv Config button on the I/O 
Configuration dialog.
Remember you can always click the Help button or press [F1] on a dialog if you 
are unfamiliar with any of the required parameters.

Automatic I/O configuration
If you are offline and have your System Communications configured for 
connection to an SLC 5/03™, SLC 5/04™ or SLC 5/05™ processor, you can 
enable the processor to automatically read the actual I/O configuration and 
reflect that information on the I/O Configuration window.  This can save 
considerable time.  To do this click the Read I/O Config button on the I/O 
Configuration dialog.

These figures 
represent the current 
power supply loading 
based on your 
module configuration.

These figures 
estimate the power 
available before an 
overload occurs.

This is where you receive advisory 
messages about your power supply 
selection.
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Chapter

Entering Ladder Logic

Introduction
This chapter provides information that you can use to make editing your ladder 
logic easier. 

Backing up your work
Remember to back up your work as you develop your ladder logic programs.  
RSLogix 500 uses two types of backup files that you can access at any time, and 
provides you with an auto-recovery file in the case of a power failure.  All of 
these files contain the entire description database associated with the project.
n Auto-Backup files are created automatically each time you save a project.  

You can preset how many backups should be retained for any project by 
entering a Number of Backups on the System Preferences tab of the System 
Options dialog.  Reach this tab from the Tools menu.  Then click Options 
and select the System Preference tab.  Auto-backup files (saved as .RSS files) 
have the letters BAK and a series of numbers (000 to 999) appended to the 
filename.  For example, an auto-backup created for project TEST.RSS might 
be identified as TEST_BAK000.RSS, and a more recent backup might be 
identified as TEST_BAK001.RSS.  

n Compressed Format Backup files are typically generated for archiving or 
giving to another user.  Compressed format backup files include the .RSS 
and all database files for the project compressed into a single .RS1 file.  From 
the File menu click Backup Project to generate a compressed-format backup 
file.

Tip Shortcut methods exist for most editing functions within RSLogix 
500.  You can access this list of shortcuts in the online help by 
searching the word "shortcuts" in the online help.
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Crash Recovery
If you experience a power interruption, RSLogix 500 provides you with a recent 
backup file containing current edits.
RSLogix 500 automatically creates file backups while you are working with a 
project and when you save the project.  This auto-generated recovery file 
(internal RSS file) is only available to you the next time you open a project if 
you have a system crash or your power  is interrupted.  After attempting to 
open a project after a power failure RSLogix 500 prompts you with choices.  
You can open:
n the auto-saved file, ensuring retention of any edits made before the power 

interruption.
n the last backup that you made, when you selected Save before the power 

interruption.

You can set the interval time at which auto-recovery saves of your project will 
occur.  Do this by making a setting in the Preferences dialog.  The auto-
recovery process ensures that you will be able to retain any work that had been 
done on the file between the time of the power interruption and the last manual 
save.

Tip You must have saved or closed the file you are working on at least 
one time for the auto-recovery process to work.  Therefore, it is 
good practice to save the file immediately after beginning a new 
project.  This ensures that your auto-recovery process can begin 
properly.
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Quick entry of instructions
To make your programming tasks faster, RSLogix 500 lets you map any 
available alphabetic key (A-Z) on your computer keyboard to a ladder logic 
programming instruction.

From the View menu click Properties.  Then click Quick Key Mapping to 
access the mapping list.  Make sure you have a program file window opened 
and active or you will not be able to select Properties from the View menu.

Tip You can jump to any rung in your project by clicking the Search 
menu, and then clicking Goto.  You can go to a rung in the current 
program file or you can go to a rung in another program file within 
the same project.Keyboard users can press the [Ctrl + G] key 
combination to access the Goto Rung dialog.

Double-click the word 
Free anywhere in this 
list. 

Then click a 
mnemonic from the 
drop down list to 
assign it to the key-
board key and make it 
a quick key.
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Floating instruction palette
As a convenience for selecting instructions RSLogix 500 lets you display a 
floating instruction palette.  From the View menu click Instruction Palette or 
click the palette icon.

You may have to resize the palette for your screen.  To do this click on the 
lower edge of the palette window and drag to an appropriate size.

Addressing
There are several different methods that you can use to address instructions.  
You can enter an address by:
n manually typing it in
n dragging addresses from data files or the CDM (Custom Data Monitor)
n using copy and paste from program to program

icon 
 

palette

Tip You can drag-and-drop rungs, branches, instructions, and addresses 
from file to file or from the database to a file.  To drag-and-drop, 
position the mouse pointer over a file element, click and hold down 
the left mouse button and drag the element to another location, and 
then release the mouse button.  Red boxes indicate valid locations; 
these turn green when properly selected. 
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Branching

Add a branch

Move a branch

Expand a branch

Nested branches

Parallel branches

Click this icon on the instruction toolbar to place a branch 
in your ladder logic.  If your cursor is on an instruction, the 
branch is placed immediately to the right of the instruction.  
If your cursor is on the rung number, the branch is placed 
first on the rung.

Click on the upper left corner of a branch to move the 
entire branch structure to another location in your ladder 
logic program.

Click the right leg of the branch, then drag the leg to the 
right or left.  Valid release points will be visible on the 
ladder display.

Place the cursor at the upper left corner of a branch leg, 
click the right mouse button, and select Append New 
Branch to place another branch structure within the 
original branch structure.

Place the cursor at the bottom left corner of a branch leg 
and click the right mouse button to Extend Branch Leg Up 
or Extend Branch Leg Down.
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Copy branch leg

Copy entire branch structure

Delete a branch
Place the cursor at any location on the branch and click the right mouse button.  
Then click Delete.  If you cut or delete a branch, all instructions on the branch 
are also deleted.

Branching restrictions
You are limited to a maximum of 75 parallel branches.
You are limited to a maximum of 4 nested branches. (SLC 5/02 and higher and 
MicroLogix).

Undo operation
The undo icon reverses your last action.  You can use this icon to walk through 
(and undo) your previous actions one at a time.  RSLogix 500 remembers up to 
200 previous actions.
If you want to undo a move operation, you must click undo two times.  This is 
because RSLogix 500 considers a move a series of two actions (copy and cut).  
You have to let RSLogix know that you want both the copy and the cut undone.  
If you click undo only one time when trying to undo a move, the move appears 
to be a copy, and you will see the moved element appear at both locations.

Click on the left edge of the branch leg you want to copy.  
In the picture at the left this is the center leg.  Then click 
copy in the right mouse menu.  Finally click on a rung or 
instruction in your logic and click paste from the right 
mouse menu to insert the rung leg 

Select the right leg of the branch structure, then click copy 
in the right mouse menu.  Finally click on a rung or 
instruction in your logic and click paste from the right 
mouse menu to insert the rung structure.
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Online editing
The online editing function lets you monitor and correct your ladder program 
when your programming terminal is connected to a SLC 5/03, SLC 5/04 or 
SLC 5/05 processor.  Only one programming device at a time can perform 
online edits of the program.
Online editing functions consist of inserting, replacing, and deleting rungs in an 
existing ladder program while online with the processor. 
Within your logic program RSLogix 500 places zone markers in the margin to 
the left of the left rail.  These letters signify edit zones and they indicate the type 
of ladder program edit that exists in the program.  
Lower case zone markers indicate edits that exist only in the computer memory.  
Upper case zone markers indicate edits that exist in the processor memory.  
After successfully assembling the edited rungs, the zone markers disappear. 

Lower case zone markers

Tip You can search for zone markers in your project the same way you 
might search for an instruction or an address.  Do this via the Find 
dialog using the Special button.

e (Offline and online, all controllers)  These rungs are currently under 
edit within the computer RAM.  If you are working offline, after a 
successful program verification the lower-case e will disappear and the 
edits will be incorporated into the program. If you are working online, 
after accepting the rung, the lower-case e will be replaced by an upper-
case I indicating that the rung is now in the controller's memory and will 
be inserted into the program file. 

i (Online Editing, SLC 5/03, 5/04 and 5/05 controllers only)  These 
rungs are to be inserted into the program.  Rungs marked with a lower-
case i currently exist in the computer memory and will not be entered 
into the controller until the rung is accepted (right mouse button 
selection).  After the rung is accepted, the lower-case i is replaced by an 
upper-case I.
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r (Online Editing, SLC 5/03, 5/04 and 5/05 controllers only)  These 
rungs are to be replaced in the ladder program.  Rungs marked with a 
lower-case r currently exist in the computer memory and will not be 
entered into the controller until the rung is accepted (right mouse 
button selection).  An r marked rung is always preceded by an e marked 
rung.   After the rung is accepted, the lower-case r will be replaced by 
an upper-case R.  

d (Online Editing, SLC 5/03, 5/04 and 5/05 controllers only)  These 
rungs are to be deleted from the ladder program.  Rungs marked with 
a lower-case d indicate a deletion reflected in the computer memory.  
This deletion will not be reflected in the controller until the rung is 
accepted (right mouse button selection), at which time it will be 
replaced by an upper-case D.    
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Upper case zone markers

Online editing example
This example replaces an XIC instruction with an XIO instruction with the 
same address while online. 
1. Select the rung in the program that requires editing and then from the 

Edit menu, select Start Rung Edits from the main menu or choose Start 
Rung Edits from the right mouse menu. A duplicate of the selected rung 
(preceded by the e edit zone marker) is shown in your program.  This is 
the rung that all edits will be performed on.  The r edit zone marker 
precedes the original rung (rung to be replaced).  See the example below. 

I (Online Editing, SLC 5/03, 5/04 and 5/05 controllers only)  These 
rungs have been inserted in the controller's logic program.  You can test 
the edits by selecting the Edit menu and clicking Test Edits to see how 
the rung works in the online ladder program.  Click Assemble Edits to 
finalize the rung insertion and complete the editing process.

R (Online Editing, SLC 5/03, 5/04 and 5/05 controllers only)  These 
rungs have been replaced in the controller's logic program.  Rungs 
marked with an upper-case R continue to function in the program until 
you select Test Edits to see how the new rung works in the online 
program.  Select Assemble Edits to finalize the replacement and 
complete the editing process. 

D (Online Editing, SLC 5/03, 5/04 and 5/05 controllers only)  These 
rungs have been deleted in the controller's logic program.  Rungs 
marked with an upper-case D continue to function in the program until 
you select Test Edits to see how the program functions without the 
rungs in the online program.  Select Assemble Edits to finalize the 
deletion and complete the editing process.   
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2. Make the edits to the rung.  The lower-case edit markers do not change 
since they represent changes that only exist in the computer memory; 
these changes are not yet a part of the online program in the controller.  
(At this step you can click Cancel Rung Edits to cancel the edits you have 
made to the rung.)

3. Select Accept Rung.  This changes the edit zone markers and places both 
rungs in the controller memory.  The upper-case I represents the rung 
that has been inserted into the online program.  The upper-case R 
represents the online rung that is to be replaced.  At this time the R rung 
is still operating in the program.

4. Select Test Edits.  The I-marked rung takes precedence.  The program in 
the controller will operate with the inserted rung, and the R-marked rung 
will be ignored. (Alternately you can click Cancel Edits to cancel the 
accepted I-marked rung and retain the originally programmed R-marked 
rung instead.)

5. Select Assemble Edits.  All edit zone markers disappear and the edits are 
incorporated into the online program.  There is no Undo option after 
online edits have been assembled.
Going from online to offline with rungs under edit removes the RAM 
online edits.  Make sure you have accepted edits before going offline if you 
want any changes retained in the processor.

Online editing restrictions
Your programming terminal must be connected to a SLC 5/03, SLC 5/04 or 
SLC 5/05 processor.  During an online editing session you cannot:

n resize data table files
n create or delete program files 
n change program file protection
n change index across file boundaries flag
n reconfigure the I/O
n select force protection
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ASCII editing
ASCII Editing is a function of RSLogix 500 that lets you modify instructions 
using ASCII instruction mnemonics instead of having to modify instructions 
using the ladder editor.  
A quick way to call the ASCII Editor is to double-click a rung number in the 
left margin.  If you double-click a rung with logic already on it, you will see the 
mnemonics for the existing instructions and can modify or add to them.  If you 
double-click an empty rung, you get an empty editing box into which you can 
type the mnemonics that represent the logic you want placed on the rung.

Configuring interrupts
Use interrupts to interrupt the scan of the main program to accomplish a 
certain task.  Programming requires you to enter essential criteria  for the 
interrupt to function properly.  Depending on the processor you are using, this 
criteria is entered into the Status file by accessing it directly (All SLC processors 
and MicroLogix 1000 processors) or by entering the appropriate data in the 
Function File utility (MicroLogix 1200 and 1500 processors only). 

Selectable Timed Interrupt
Use the selectable timed interrupt (STI) function to interrupt the scan of the 
main program file automatically, on a periodic basis, in order to scan a specified 
subroutine file.  You can specify the time interval when your selectable timed 
interrupt routine will execute.

Tip Another quick method to call the ASCII text editor is to click the 
rung number and then press the forward slash key (/) on your 
keyboard.

Processor Type: Action:

All SLC  and ML 
1000 

Select a program file for the STI by double-clicking the S2 
data file icon in the project tree.  Then click the STI tab and 
enter the information needed to define the STI.  Press the 
Help button if you need more information.

ML1200 and 
ML1500 

Select a program file for the STI by double-clicking the 
Function Files icon in the project tree.  Then click the STI 
tab and enter the information needed to define the STI.  
Press the Help button if you need more information.
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Discrete Input Interrupt
Use the Discrete Input Interrupt (DII) for high-speed processing applications 
or any application that needs to respond to an event quickly.  This function 
allows the processor to execute a ladder subroutine when the input bit pattern 
of a discrete I/O card matches a compare value that you programmed.

Processor Type: Action:

All SLC   Double-click the S2 data file icon in the project tree.  Then 
click the DII tab and enter the information needed to define 
the DII.  Press the Help button if you need more information.

ML1000  ML1200 
ML1500 

Unavailable with these processors.
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Chapter

Importing or Exporting 
the Documentation 
Database

Introduction
The import and export utilities are available from the Tools menu by clicking 
Database.  Use the import functionality in RSLogix 500 when you want to apply 
documentation that already exists to a project you are currently developing in 
RSLogix 500.  Use the export functionality in RSLogix 500 to make the 
database documentation that is part of your current RSLogix 500 project 
available to other projects.  
When sharing RSLogix 500 database information with other RSI applications, 
like RSView 32, you must use the Save database as external file checkbox on 
the Save As dialog to make the database file available to that application.  
Access the Save As dialog by clicking File and then clicking Save As.

Import database
You can apply documentation to newly created logic files by importing existing 
database documentation.  The existing documentation might come from:
n projects developed using Rockwell Software's Dos-based AI or APS 

programming software
n another project developed using RSLogix 500
n a spreadsheet application, like Microsoft Excel™ (saved as a .CSV file)
n an ASCII text file
Sometimes when you import a documentation database, there may be 
conflicting entries in the import file and the database.  This is called a collision.  
Before you begin any import you can select if you want the imported database 
instance or the current database instance discarded if collisions occur. 
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A.I. project documentation database
Choose the Native Import option in the Database menu to import database 
documentation consisting of:
n address symbols and descriptions (.DSC files)
n page title and rung descriptions (.RPD files)

APS project documentation database
Choose the Native Import option in the Database menu to import database 
documentation consisting of:
n address symbols and descriptions 
n page title and rung descriptions 
n instruction comments 
By default the file type selected for import is a .OP$ file.  The .OP$ file is the 
database control file.  It references individual database files (for example the 
symbol/description file or the page title/rung description file) that reside in the 
same directory as the .OP$ file.  After an import completes, RSLogix 500 
creates a log file that informs you which database files successfully imported 
and which database files contained errors and could not successfully be 
imported.  

RSLogix 500 documentation database
Choose the Native Import option in the Database menu to import database 
documentation consisting of:
n address symbols and descriptions 
n page title and rung descriptions 
n instruction comments 
n symbol groups
By default the file type selected for import is a .CTD file.  The .CTD file is the 
database control file.  It references individual database files (for example the 
symbol/description file or the page title/rung description file) that reside in the 
same directory as the .CTD file.  After an import completes, RSLogix 500 
creates a log file that informs you which database files successfully imported 
and which database files contained errors and could not successfully be 
imported.  For a complete list of RSLogix 500 file extensions for individual 
database documentation refer to the online help and search "file extensions."
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CSV (Comma Separated Values) file
Choose the ASCII Import option in the Database menu to import database 
documentation contained in a .CSV file and consisting of:
n address symbols and descriptions 
n instruction comments 
n symbol groups
For an example of a .CSV file, refer to the online help and search "CSV format 
for import/export."

ASCII delimited text file
You can import documentation files that were created using RSLogix 500 
software or AI software and exported and saved as ASCII delimited files.  
ASCII delimited means that the fields for each RSLogix 500 database record 
are enclosed in quote marks and separated by commas.  
Choose the ASCII Import option in the Database menu to import database 
documentation contained in an ASCII delimited text file.  Choose from:
n address symbols and descriptions (.EAS files)
n page title and rung descriptions (.ERP files)
n instruction comments (.EIC files)
n symbol groups (.ESG files)
Users can specify any extension instead of the default extension for each file 
type (shown above in parenthesis) when using Rockwell Software's AI or 
RSLogix 500 software.
An example of each of the above files can be found in the "ASCII Export" 
section of this manual.

Export database
Use the export functionality in RSLogix 500 to make the database 
documentation that is part of your current RSLogix 500 project available to 
other projects.  
You can select the display format for descriptions in the exported file.  Choose 
"treat descriptions as five, 15-character lines of text" if you are exporting a 
database that will be used by Rockwell Software's AI or APS programming 
packages.
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You can export documentation to the following output formats:
n ASCII delimited RS500 format
n ASCII delimited AI format
n ASCII delimited APS format
n a comma separated value file (.CSV file)
After it has been exported, you can edit the ASCII file with a text editor, or load 
the file into another database.
When you export database documentation to AI or APS ASCII delimited 
format, the symbols, descriptions, and instruction comments may be truncated 
due to size restrictions imposed by the AI/APS databases.  This may result in 
conflicts in the exported data.

RS500 ASCII delimited text file examples
The examples in this section show how the documentation would be 
represented in an exported ASCII text file, using the RS500 output format.  
Each field in a line of ASCII text is enclosed by quotes and separated by a 
comma.

Address symbols and descriptions (.EAS files)
"B30","0","SYMBOL","description","","","","","0","","","0","GROUP_NAME"

ASCII Field # Maximum Length Contents

1 39 characters Address

2 -- Scope (0=global, 2-255=local program file #)

3 20 characters Symbol

4 20 characters Description line 1

5 20 characters Description line 2

6 20 characters Description line 3

7 20 characters Description line 4

8 20 characters Description line 5

9 12 characters Device code (always 0 for addresses that are 
not real I/O)

10 9 characters Device description above

11 9 characters Device description below

12 -- Disable xref flag, (0=enabled, 1=disabled)

13 20 characters Symbol group name
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Page title and rung descriptions (.ERP files)
"RUNG000002-000002","page title","rung comment\"

Instruction comments (.EIC files)
"B3/0","XIC","ins comment","","","",""

Symbol groups (.ESG files)
"GROUP_NAME","description"

A.I. ASCII delimited text file examples
These examples show how a line might appear in an ASCII text file exported 
using the AI output format.  Each field in a line of ASCII text is enclosed by 
quotes and separated by a comma.

Address symbols and descriptions (.EAS files)
"B3/0","0","SYMBOL","description","","","","","0","","","0"

The field breakdown of AI ASCII delimited text is the same as shown for 
RS500 ASCII output format, except the symbol and description fields are 
limited to 15 characters and there is no symbol group field.

ASCII Field # Maximum Length Contents

1 39 characters Data table address or rung identifier

2 -- Page title

3 20 characters Rung description

ASCII Field # Maximum Length Contents

1 39 characters Address

2 3 characters Instruction type

3 20 characters Comment line 1

4 20 characters Comment line 2

5 20 characters Comment line 3

6 20 characters Comment line 4

7 20 characters Comment line 5

ASCII Field # Maximum Length Contents

1 20 characters Symbol group name

2 80 characters Symbol group description
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Page title and rung descriptions (.ERP files)
"RUNG002-0002","page title","rung comment\"

The field breakdown of AI ASCII delimited text is the same as shown for 
RS500 ASCII output format.

APS ASCII delimited text file
APS documentation database files saved to ASCII text format contain 
keywords.  Keywords tell the software whether the information immediately 
following the keyword is a rung comment, an instruction comment, an address 
comment, or a symbol.  Symbol and address comment examples are shown 
below.
SYM     B3/0     SYMBOL
AC      B3/0     “descriptio”
Refer to your APS programming manual for a complete list of keywords and 
an explanation of how an APS ASCII text file is built.

CSV format
Search "CSV format for import/export" in the RSLogix 500 online help for 
complete details.



Monitoring Data   n 43

Chapter

Monitoring Data

Introduction
RSLogix 500 provides you with several customized methods for monitoring 
data in your data table files.  
n Multipoint Monitor
n Custom Data Monitor
n Histograms
n Data Logging (MicroLogix 1500LRP only)
The Multipoint Monitor and Custom Data Monitor methods let you compose 
lists of addresses that you monitor frequently, or lists of addresses with 
interrelated functionality, so that you can view, document, protect or even 
force the changing data values from a single source file.
When you are online, you can use histograms and trends to see how your 
program is behaving over time, by examining bits as the program runs in the 
SLC controller.  
The data logging feature lets you use ladder logic to enable recording data for 
predefined sets of addresses.  Your data can be date and time stamped.

Multipoint Monitor
This is only available with MicroLogix 1000, SLC 5/03 - OS302, SLC 5/04 - 
OS401 and OS410, and SLC 5/05 controllers.  The Multipoint Monitor 
function can only be used to monitor bit addresses.  If you want to monitor 
word addresses as well as bit addresses, use the Custom Data Monitor.
Bit addresses in a multipoint list can come from any data table file.  They do 
not have to be from the same data table file.
You can use a multipoint list to:
n change the on/off state of bits
n set and clear forces on I/O points
n define separate descriptions for on and off state 
n write protect a bit
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To access the Multipoint Monitor feature, double-click the Multipoint Monitor 
icon located in the project tree.

The offline multipoint list is stored in the project file.  It is not part of the 
processor image. The online multipoint list is stored in the processor memory 
and is, therefore, cleared whenever the processor memory is cleared.  
When using the MicroLogix controller, descriptions are always stored in 
the.RSS file.  With the SLC 5/04 and SLC 5/05 controllers the descriptions are 
stored in the processor.

Custom Data Monitor (CDM)
This is available with all controllers.  The Custom Data Monitor function can 
be used to monitor bit addresses and word addresses.  
Addresses in a custom data monitor list can come from any data table file.  They 
do not have to be from the same data table file.
Features of the custom data monitor include:
n CDM lists can contain bit addresses or word addresses.
n CDM lists can contain ASCII comments to help you clarify bit listings.
n You can define up to 255 (CDM) lists per project (0-254, inclusive).  
n The CDM name is limited to 20 characters. 
n The CDM description is limited to 59 characters. 
n You can click and drag addresses from the data tables to the CDM file.
n You can use the [Ctrl] and [Shift] accelerator keys to drag more than one 

address at a time from the data tables. 

To access the Custom Data Monitor feature, double-click the CDM file icon 
located in the project tree.

You can provide 
separate 
descriptions (up to 
16 characters) for 
the on- and off- 
state of a bit.

Use only bit addresses in a multipoint monitor list.

 

By default an untitled CDM file (#0) is included in your
project.  Rename this file when you add your addresses.
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Histograms
Use the histogram functionality in RSLogix 500 to get information about how 
an address's data value changes over time.   
You must be online with the SLC controller to access the histogram function.  
From the Comms menu, click Histogram to display the Histogram dialog.

By clicking Start on this dialog, the histogram function sends a message to the 
SLC controller to begin logging data.  Each time the address value changes, the 
controller stores the value for the address in a histogram buffer, logging both 
the new value and the time interval between value changes.  This data is 
represented in the top portion of the histogram display window.
If you frequently log certain data, you can save the configuration and simply 
load it without having to enter new parameters each time.  Use Save and Load  
(accessible from the right mouse menu) for this functionality.

Data Logging (MicroLogix 1500LRP only)
Use the data logging feature to define and edit data sets for later retrieval by a 
communication device.  The data is retentive in the controller through power 
cycles.
Access data logging from the project tree by clicking the Configuration icon in 
the Data Logging folder.  Then right-click on Data Log Configuration and 
select New from the context menu

Use this drop-down list box 
to select a time base for the 
histogram (in seconds).

If you don’t see data values 
changing, it is possible that 
your time base is incorrect 
for the addresses you are 
monitoring.
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Enable data logging for any queue when the DLG instruction in your ladder 
logic designating that queue goes from False to True.

This is the number of samples 
that you would like for each 
record retained.  When this limit is 
reached and a new sample is 
recorded the oldest record 
is dumped from the record.

By default the separator 
character is a space.  
Although it may look like 
there is nothing in this box, 
there is actually a space 
character.

Type an address here and then 
click Accept or press [Enter] to 
place it in the current address list.
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Chapter

Saving and Loading SLC 
Libraries

Introduction
SLC library files are ASCII text files of the processor memory that contain the 
ladder logic, data table file, and force tables.  By  exporting (saving to file) and 
importing (loading into a new project) these SLC files, you can reuse existing 
work.  SLC files can be opened in any ASCII text editor and modified for use 
in your projects.
Things to remember about library files
n Only verified project data can be saved to a .SLC file.
n Exported SLC libraries limit symbols to 15 characters.  If you have a project 

file with database symbols that are 20 characters in length, exporting the 
project to a SLC library will truncate the symbols to 15 characters maximum.

n Graphics characters are not allowed.
n The file name of the ASCII file can contain up to eight characters consisting 

of (A-Z, 0-9, or the underscore character).
n The file extension of the ASCII processor memory file must be SLC.
n The text editor you use with an ASCII text file must produce only printable 

ASCII characters, with no control characters or hidden characters.

Exporting libraries
You can save entire projects or partial libraries.  To save a partial library, select 
the rungs you want to save in the library.  If you select no rungs a complete save 
occurs.  Then from the right mouse menu click Copy to SLC Library, and after 
supplying the path and filename, click Save.

Tip You can examine any error messages resulting after an import or 
export operation by examining the .LOG file.  This file is stored in 
the directory named on the Preferences tab accessed by clicking the 
Tools menu and selecting Options.  You can change this default 
directory.
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You can place a description in the SLC file by typing the description in the 
Library Description field.  This description appears when you import the 
library.

Importing libraries
Importing a .SLC library converts the processor memory file, previously 
exported as a .SLC ASCII file, to the RSLogix 5 .RSP format. 
Open the project into which you want to load the library.  Then from the right 
mouse menu click Paste from SLC file.
If you are loading a complete program image into an existing project, data table 
values in the library will overwrite values in the base program, and incoming 
rungs will be appended to existing program files.

If you choose Partial Save, make sure 
you selected the rungs before displaying 
this window.

Checking Annotate Library places additional information 
in the SLC file about the rungs’ position in the original 
program.  This information is used for troubleshooting a 
library file, and can help you if you intend to manually edit 
the .SLC file in a text editor.
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If you are loading a partial library, select the rung in your program that you want 
the library rungs to precede.  The library rungs will always be placed before the 
rung you select.  Data table values from the library will overwrite existing data 
table values for those addresses already present in the base project

Choose the indexed mode and then click the Edit Index button if 
you want to display a Fixup table from which you can adjust the 
addresses in the imported library so that there are no conflicts with 
the addresses in the base program.

If you change base address I:000/0 to I:016/00 (in the 
Fixup column) and press [Enter], the addresses that 
are relative to I:000/00 change to follow the change in 
the base.  If there were more addresses relative to base 
address I:000/0, each one would be offset by the 
change applied to the octal base address.  Relative 
addresses include all the addresses in the list of the 
same data file up to the next Base address.

You can change the type address.  
Double-click and select Base, 
Relative, or Global from the drop-
down listbox.  An address set to 
Global is not affected by indexing 
to a preceding base address.
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Chapter

Getting the Information 
You Need

Introduction
Use this chapter to review the sources of additional information on RSLogix 
500 software, including online help, RSLogix 500 training, and technical 
support. 
You can find out more information about RSLogix 500 software by consulting:
n RSLogix 500 online help
n RSLogix 500 training
n Technical support services

RSLogix 500 online help
RSLogix 500 online help provides general overview information, a description 
of the fields on every dialog box, and step-by-step procedures for working with 
all of the features of RSLogix 500.  To open online help while running RSLogix 
500 you can:
n choose Help from the menu on the RSLogix 500 main window
n click the Help button on any RSLogix 500 dialog box
n press F1 on any instruction, dialog box, or window view
n expand the Help folder in the project tree and then double-click on any 

informative file listed to launch a help file.
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Opening an expandable table of contents
To open an outline of the entire RSLogix 500 online help system:
n click Help on the menu bar and then click Contents
n click the Help folder in the project tree and then double-click Contents

Double-click any 
closed book icon 
to reveal the 
content.

To collapse the
outline, double-
click an open 
book icon.

To go to a topic 
double-click a 
page.

Double-click the 
procedures book 
to see a list of
 tasks you can 
accomplish using 
any function of 
the software. 
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Learning RSLogix 500 step-by-step

In Help you will find a Step-by-Step topic that asks what you want to do and 
lets you select from many of the tasks you might want to perform.  
To quickly step through the major tasks associated with creating a project, 
going online, and monitoring data, click on the check boxes.  If you want more 
information about some of the other things that you can do associated with a 
major task, click the specific procedure.

Click this book icon to get more
background reference material
associated with any procedure.

Once you have completed reading the 
“How To” window, you can select
another task from this list.
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Quick tips about Windows Operating Systems and 
RSLogix 500

Windows operating systems provide some functionality you may not be 
familiar with.  The RSLogix 500 online help can point out some shortcuts and 
navigational techniques that can make your work easier.  Just select 
Understanding the Operating Environment from the contents page of the 
online help.  

Instruction Set help
All of the instructions available to you in RSLogix 500 have context-sensitive 
help.  You can click an instruction in your ladder logic for help about the 
parameters required or for information about why you might use one type of 
instruction instead of another.
Each topic in the instruction set online help also gives you information about 
which processors can use the instruction and an example of the instruction with 
sample parameters. 



Activation   n 55

Appendix

Activation

Rockwell Software’s products are copy-protected. Only a computer with access 
to the activation key can run the software. The key is located in an activation 
file, which is originally located on the Master disk supplied with the RSLogix 
500 product. The activation file contains one activation key per product. Each 
key contains one or more licenses depending on how many copies of the 
product you have purchased.

During the setup process, the setup program gives you the opportunity to 
move the activation file from the Master disk to the root directory of the drive 
on which you’re installing the software.
When you launch RSLogix 500, the software first checks your local hard drives, 
then network hard drives, and finally local floppy drives for activation. If the 
system fails to detect either the activation file or the Master disk, you will 
receive an error message stating that activation is required to run the RSLogix 
500 software.

Store your Master disk in a safe place. If your activation becomes 
damaged, the Master disk may be the only means to run your 
software in an emergency.

Systems attached to extensive networks can take quite a while to 
search for activation files on all available drives. You can use the 
CHECKDRIVES environment variable to specify and/or limit 
the drives your software checks for activation files and to specify 
the order in which they are checked. Refer to the activation 
utilities online help file by selecting Help > Copy Protection.

Tip

Tip
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Protecting your activation files

To avoid damaging your activation files, do not perform the following 
operations with activation files on the hard drive. 
n Restore from backup
n Upgrade the operating system
n Reinstall the same version of DOS
n Uninstall DOS
n Compress or uncompress the hard drive 
n Turn off Windows for Workgroups 32-bit file access. If activation files were 

moved to a hard drive with 32-bit file access on, turning off 32-bit file access 
results in activation files being lost. (You can turn on 32-bit disk access and 
32-bit file access in Windows for Workgroups without harming the 
activation file.)

Defragmentation utilities will not harm activation files.
Before running any type of utility that may modify the structure or organization 
of the hard drive, remove activation from the hard drive:
1. Use the Move Activation utility (EvMove) to move activation files from 

the hard drive to an activation disk.

Run EVMOVE.EXE from your hard drive (located in C:\Program 
Files\Rockwell Software\RSUtil if you accepted the default directory 
location during installation).

2. Perform the hard disk operation.

Certain anti-virus software packages, such as Norton Anti-virus, 
can corrupt the activation files. Configure your anti-virus 
software to avoid checking the files EVRSI.SYS and 
386SWAP.PAR.

Caution

Do not use the the Move Activation utility if Rockwell Software 
products are currently running. Ensure all software programs are 
closed before initiating the EvMove utility.

Caution
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3. Move the activation files back to the hard drive.

Activating RSLogix 500
Depending on your needs, you can activate RSLogix 500 from any of the 
following:
Hard drive. The activation key resides on your computer’s hard disk. Use this 
method if you will typically use RSLogix 500 on only one computer. This is the 
default method if you activate RSLogix 500 during installation. To run RSLogix 
500 on a different computer, move the activation key back to the Master disk, 
and then to the hard drive of the new computer.
Diskette drive. The activation key resides on a floppy disk (activation disk). Use 
this method if you will typically use RSLogix 500 on more than one computer, 
for example, if you want to run RSLogix 500 on a desktop computer at some 
times and a portable computer at others.
Network drive. The activation keys reside on a network drive. Use this method 
if you have purchased multiple licenses of the software and want several users 
to be able to activate the software over a network. Refer to the online help for 
instructions on moving activation to a network drive (refer to the “Finding 
more information about activation” section in this chapter to access online 
help).

Running the activation utilities
The utilities for moving and resetting activation are called EvMove and Reset 
respectively. Reset is used when an activation file has been damaged. The 
EVMOVE.EXE and RESET.EXE files are located on your hard drive (located 
in C:\Program Files\Rockwell Software\RSUtil if you accepted the default 
directory location during installation). To run these programs, select Start > 
Progams > Rockwell Software > Utilities > Move Activation or Reset 
Activation.

You must use the move utility, EvMove, to move activation files. 
Attempts to copy, move or e-mail an activation file by other 
means will damage the file.

Caution
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Finding more information about activation
The online help (COPYPROT.HLP) provides more extensive information on 
activation including subjects such as:
KEYDISK. Set this environment variable to tell your computer to look for 
activation on floppy drives
CHECKDRIVES. Specify which drives to search for activation
network activation. Move activation to a network server to allow multiple 
users access to the activation
moving activation. See detailed instructions for moving activation
resetting activation. See detailed instructions for using the Reset utility to 
repair a damaged activation file
troubleshooting. Look up error messages, get problem-solving suggestions
You can access online help:
n from the Help button on one of the EvMove or Reset dialog boxes.
n from RSLogix 500 by selecting Help > Copy Protection from the main 

menu.
n without running either RSLogix 500 or the activation utilities. From the 

Windows Start menu, select Programs > Rockwell Software > Utilities > 
Activation Help (if you accepted the default directory location during 
installation).

Some common questions
Following are some common problems that people encounter with activation 
and their solutions.

My activation files were damaged. What should I 
do?
If you have lost the activation because the activation file is damaged, you need 
to reset activation. Follow the Reset Codes instructions on the Rockwell 
Software Technical Support web page, or call the technical support telephone 
number. The web page and telephone number are both listed on the inside 
front cover of this guide.
If you cannot obtain a reset code immediately, follow these instructions to use 
the Master disk to activate the software as a temporary solution.
To use the Master disk to activate software:
1. Set the KEYDISK environment variable to TRUE. (Please refer to the 

online help.)



Activation   n  59

2. Insert your Master disk in the floppy drive.
3. Run your software as usual. Your software will find the activation on the 

Master disk.

I accidentally deleted the software directory on my 
hard drive. Do I need to call Rockwell Software for 
replacement activation files?
No. Deleting the program files does not delete your activation. The activation 
files are not stored in the program directory; they are located in the root 
directory. Your activation files will not be lost unless you format the hard drive, 
tamper with hidden files in the root directory, or perform certain other hard 
drive operations (refer to the “Protecting your activation files” section in this 
chapter for more information).
To get the software running again, simply reinstall the software, but do not 
move the activation when given the opportunity.

Why can’t I move activation to a new floppy disk on 
a Windows NT system?
It has to do with a disk modification that NT does not allow. If you have access 
to a Windows 95 or 98 machine, you can create a disk that will work under NT. 
Format a floppy and move any activation file to it under Windows 95 or 98. 
(You can move the activation back off the disk if you want to keep it where it 
was.) Then take that disk to your Windows NT machine and move the 
activation to it.
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